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Editing and annotating articles can be an extremely tedious task. I know I've zoned out on multiple occasions, letting my brain read on autopilot, only to realize afterward that I've highlighted entire paragraphs, which defeats the purpose of highlighting. This article will give you a step-by-step guide on how to unhighlight in PDF with different PDF
editors, including Wondershare PDFelement - PDF Editor Wondershare PDFelement Wondershare PDFelement. Part 1: How to Unhighlight in PDF with PDFelement The most important thing is to have a highlight eraser downloaded and installed on your PC to ensure you do the job right. Wondershare PDFelement - PDF Editor Wondershare PDFelement
Wondershare PDFelement is a program that lets you undo yellow highlights all in once. Once it is installed, you are ready to go. You can also highlight, underline PDF, add comments and notes, edit text, images and lines with PDFelement, too. It's an all-in-one PDF solution to your PDF problems. G2 Rating: 4.5/5 |100% Secure Method 1: Undo
Highlighting in PDF by Right-clicking Step 1. Import PDF into PDFelement Import the PDF document you would like to work on into PDFelement by clicking the "+" button on the Home screen. Step 2. Unhighlight Text in PDF Once your file is open, go to the "Comment" tab and select the content you've already added highlights. Click on the highlighter,
a box will appear around the text, then press the "Delete" key on your keyboard to remove it directly Method 2: Undo All Highlights in One Page If your PDF has many highlights in one PDF, you can use PDFelement to remove all highlights from PDF on one page at once. Make sure the "Select" tool is enabled, then right-click the highlight to choose
"Select All," then all the highlights on this page will be selected automatically. G2 Rating: 4.5/5 |100% Secure Then you can press the "Delete" key to undo all the highlights. Now you can read the PDF page without any highlighted text. Method 3: Delete All Highlights in PDF If you want to quickly delete all highlights in the PDF files, PDFelement can
help you with that. Its comment panel allows you to select highlights across pages and delete them all at once. G2 Rating: 4.5/5 |100% Secure Step 1. Unhighlight PDF After opening your PDF file in PDFelement, click the "Comment" icon to display the comment panel, where all highlights in the file can be found. Step 2. Unhighlight All Text in the Whole
PDF File After displaying the comment panel, you can hold the "Ctrl" key and click all the highlights to be selected. Then you can right-click and tap on the "Delete" option to delete all highlights. Enjoy the PDF without highlights! G2 Rating: 4.5/5 |100% Secure A Video Guide on How to Unhighlight PDFs Part 2: How to Unhighlight in PDF on Mac
PDFelement for Mac is a very exceptional tool when it comes to unhighlight PDF in Mac. Mac users who wish to cover the process without any inconvenience should consider the following steps. G2 Rating: 4.5/5 |100% Secure Step 1. Upload PDF File into PDFelement for Mac You need to download and install PDFelement across Mac. Once installed,
open the platform, and tap on “Open” from the options displayed on the home screen. Step 2. Unhighlight Text in PDF Once you open the document, lead to the text that is highlighted. Double-tap on the highlighted text to select it. A bar showing the properties of the highlighted text appears on the front. You need to hover your mouse across the bar and
tap on the ‘Delete’ icon to unhighlight text in PDF with ease. Save the document after unhighlighting the text across the document. Part 3: Steps to Unhighlight PDF in Adobe Acrobat Reader Users can prefer working on one of the oldest PDF editors in the market. Adobe Acrobat provides a very intuitive user interface to work on. To understand how to
unhighlight in Adobe with ease, you are advised to look into the following steps. Step 1: Launch the platform across the device and tap on “My Computer” from the left panel to open the options to import file across it. Tap on “Browse” to import the files across Adobe Acrobat successfully. Step 2: On importing the file, simply navigate to the point where
you wish to unhighlight PDF. Tap on the highlighted content to let a small-menu open on the screen for making changes across the highlighted content. Step 3: Tap on the “Delete” icon present in the menu to unhighlight your PDF successfully. Save the file once done. Part 4: How to Unhighlight Text in PDF with Foxit PDF Reader Foxit PDF Reader is
another impressive offline PDF editor that unhighlight PDF with ease. You are required to follow the steps as explained below to understand how to unhighlight in PDF successfully with Foxit PDF Reader. Step 1: Open Foxit PDF Reader on your desktop and tap on “Open Files” to import the PDF document onto the platform. Step 2: On opening the file
successfully across Foxit PDF Reader, tap on the ‘Comment’ icon present on the left-hand side of the screen. This will show you all the highlights that are present across the document. Step 3: On selecting any of the comments, you can unhighlight the respective text across it. Tap on the three-dotted icon along with the comment and select “Delete” from
the drop-down menu to unhighlight PDF. An All-in-one PDF Solution If you are looking forward to unhighlight text within PDF documents, there are some factors that you need to work on. PDF tools that feature the best interface to work on are preferred for such tasks. If the process of unhighlighting PDF is tough, the tool will not save time compared to
other competitors in the market. To get the best results, it is advised that users should adopt PDFelement as the tool to unhighlight PDF. PDFelement provides users with one of the best interfaces with a feature-rich platform to work on. Rather than restricting the working of their user, PDFelement allows you to make significant edits across the PDF file
for free. This tool turns out to be the best option in unhighlighting PDF documents. G2 Rating: 4.5/5 |100% Secure PDFelement comes with a lot of features as the best PDF highlighting remover, allowing you to easily finish any task with PDF. You no longer have to wonder how to remove or add text, add or remove images, copy and paste images,
change fonts, and so on. The editing function presents you with a large number of choices to edit PDF. What's more, its OCR feature converts scanned documents into a state that can be edited. The tools on PDFelement are meant to support your daily tasks and improve document collaboration. Aside from the highlighter tool, there are many other
annotation features such as underline, strikethrough, sticky notes, and stamps that will allow your team to communicate during the editing and brainstorming process effectively. Coupled with our other features - such as OCR, conversion, form creation, and data extraction tools. Free Download or Buy PDFelement right now! Free Download or Buy
PDFelement right now! Try for Free right now! Try for Free right now! Enjoy sharper detail, more accurate color, lifelike lighting, believable backgrounds, and more with our new model update. Your generated images will be more polished than ever.See What's NewExplore how consumers want to see climate stories told today, and what that means for
your visuals.Download Our Latest VisualGPS ReportData-backed trends. Generative Al demos. Answers to your usage rights questions. Our original video podcast covers it all—now on demand.Watch NowEnjoy sharper detail, more accurate color, lifelike lighting, believable backgrounds, and more with our new model update. Your generated images will
be more polished than ever.See What's NewExplore how consumers want to see climate stories told today, and what that means for your visuals.Download Our Latest VisualGPS ReportData-backed trends. Generative Al demos. Answers to your usage rights questions. Our original video podcast covers it all—now on demand.Watch NowEnjoy sharper
detail, more accurate color, lifelike lighting, believable backgrounds, and more with our new model update. Your generated images will be more polished than ever.See What's NewExplore how consumers want to see climate stories told today, and what that means for your visuals.Download Our Latest VisualGPS ReportData-backed trends. Generative Al
demos. Answers to your usage rights questions. Our original video podcast covers it all—now on demand.Watch Now , the free encyclopedia that anyone can edit. 107,766 active editors 7,028,274 articles in English Lesley James McNair (25 May 1883 - 25 July 1944) was a lieutenant general of the United States Army who served in both world wars, and
previously saw service in the Veracruz occupation and the Pancho Villa Expedition. During World War I, he served with the American Expeditionary Forces on the Western Front. At 35, he became the Army's second-youngest general officer. During the early stages of World War II, he was the commander of Army Ground Forces, and played the leading
role in the organization, equipping, and training of Army units before they departed for overseas combat. He was killed on 25 July 1944 while in France as commander of the fictitious First United States Army Group, part of Operation Quicksilver, a deception plan for the invasion of Normandy. McNair died when the US Eighth Air Force attempted to use
heavy bombers in support of ground combat troops, and several planes dropped payloads short of their targets. He received a posthumous promotion to general. (Full article...) Recently featured: Second Test, 1948 Ashes series Daily News Building Hippocampus Archive By email More featured articles About State flag of Transnistria ... that the state
flag of Transnistria (pictured) features communist symbols, even though Transnistria is not a communist state? ... that actor Suja Khondokar served as a flight attendant aboard the inaugural commercial flight of Biman Bangladesh Airlines? ... that Peru's fishing industry is the world's largest producer of fishmeal and fish 0il? ... that the Albanian noble
Blasius Mataranga may have been captured and killed by the Balsha family—after they lured him into peace talks with a false promise of safe conduct? ... that Mayu Sakai found drawing Peter Pan Syndrome difficult because of its fantasy elements? ... that American football player Bob Wicks was teammates with the same quarterback from fourth grade
through college? ... that from 1986 to 1988, a Boston TV station was the only one in the U.S. to broadcast digital audio in its video signal? ... that Archbishop Letard II of Nazareth was one of only a few fellow bishops about whom William of Tyre had something nice to say? ... that some Italians eat eggplants with chocolate? Archive Start a new article
Nominate an article Ozzy Osbourne Armed clashes erupt in the Cambodia-Thailand border conflict. Ozzy Osbourne (pictured), the lead singer of Black Sabbath, dies at the age of 76. A fighter jet crashes into a college in Dhaka, Bangladesh, killing more than 30 people. In golf, Scottie Scheffler wins the Open Championship. Ongoing: Gaza war Russian
invasion of Ukraine timeline Sudanese civil war timeline Recent deaths: Chuck Mangione Hulk Hogan Thomas Anthony Durkin Giora Epstein Béatrice Uria-Monzon Rex White Roger Norrington Edwin Feulner Nominate an article July 25: National Day of Galicia, Saint James's Day, Tenjin Matsuri The Concorde involved in the Air France Flight 4590
accident 1261 - Alexios Strategopoulos led Nicaean forces to recapture Constantinople, leading to the reestablishment of the Byzantine Empire and the end of the Latin Empire. 1893 - The Corinth Canal was formally opened, bisecting the narrow Isthmus of Corinth in Greece to connect the Ionian Sea's Gulf of Corinth with the Aegean Sea's Saronic
Gulf. 1950 - Korean War: After American troops withdrew, North Korean forces captured the village of Yongdong in South Korea. 2000 - Air France Flight 4590 (plane used pictured), a Concorde en route from Paris to New York, crashed in Gonesse, France, killing all 109 passengers on board and four people on the ground. 2010 - WikiLeaks published
75,000 classified documents about the War in Afghanistan in one of the largest leaks in U.S. military history. Sibylla, Queen of Jerusalem (d. 1190)Matt LeBlanc (b. 1967)Meg Donnelly (b. 2000)Azimzhan Askarov (d. 2020) More anniversaries: July 24 July 25 July 26 Archive By email List of days of the year About The Carousel at Glen Echo Park
Amusement rides on the National Register of Historic Places (NRHP) are located throughout the United States. These individual ride listings consist mainly of carousels, but also include roller coasters, trains, and other ride types. Many NRHP-listed rides operate within amusement parks, with more than one present in Cedar Point, Lagoon, and Santa
Cruz Beach Boardwalk. There are also high concentrations in New York City, the Greater Binghamton area in New York state, and Portland, Oregon. The first NRHP amusement ride listing was added in 1975 for the Idora Park Merry-Go-Round (delisted in 1985). The listing for the Crescent Park Looff Carousel was added in 1976 and is the ride that has
existed on the NRHP the longest. The listing for the Portland Zoo Railway Historic District was created in 2020 and is the newest ride entry on the NRHP. Several NRHP-listed rides, including the Leap-the-Dips roller coaster, have a higher National Historic Landmark status. Of the nearly 100,000 NRHP listings, fewer than 100 are for amusement rides.
(Full list...) Recently featured: One Direction discography Kerivoulines Accolades received by Inception Archive More featured lists Hudson Yards is a 28-acre (11-hectare) real-estate development located in Hudson Yards, a neighborhood of the New York City borough of Manhattan. It is situated on the waterfront of the Hudson River, on a platform built
over the West Side Yard, a storage depot for the Long Island Rail Road. Related Companies and Oxford Properties are the primary developers and major equity partners in the project, with the master plan designed by the architectural firm Kohn Pedersen Fox. Construction began in 2012 and the first phase opened in 2019, with completion of the second
phase expected by 2032. Major office tenants in the development include Warner Bros. Discovery, L'Oréal, and Wells Fargo among others. This photograph shows the skyscrapers of Hudson Yards, viewed across the Hudson River from Weehawken, New Jersey, in 2021. Photograph credit: Tony Jin Recently featured: Emperor angelfish Amalia Rodrigues
Atari video game burial Archive More featured pictures Community portal - The central hub for editors, with resources, links, tasks, and announcements. Village pump - Forum for discussions about Wikipedia itself, including policies and technical issues. Site news - Sources of news about Wikipedia and the broader Wikimedia movement. Teahouse - Ask
basic questions about using or editing Wikipedia. Help desk - Ask questions about using or editing Wikipedia. Reference desk - Ask research questions about encyclopedic topics. Content portals - A unique way to navigate the encyclopedia. Wikipedia is written by volunteer editors and hosted by the Wikimedia Foundation, a non-profit organization that
also hosts a range of other volunteer projects: CommonsFree media repository MediaWikiWiki software development Meta-WikiWikimedia project coordination WikibooksFree textbooks and manuals WikidataFree knowledge base WikinewsFree-content news WikiquoteCollection of quotations WikisourceFree-content library WikispeciesDirectory of
species WikiversityFree learning tools WikivoyageFree travel guide WiktionaryDictionary and thesaurus This Wikipedia is written in English. Many other Wikipedias are available; some of the largest are listed below. 1,000,000+ articles au )l Deutsch Espafiol s, Francais Italiano Nederlands H#&E Polski Portugués Pycckuit Svenska YkpaiHchka
Tiéng Viét 13X 250,000+ articles Bahasa Indonesia Bahasa Melayu Ban-1am-gui Brnarapcku Catala Cestina Dansk Eesti EAAnvikd& Esperanto Euskara nnay 2uytiniit Magyar Norsk bokmal Roméana Simple English Slovenc¢ina Srpski Srpskohrvatski Suomi Tiirkce O‘zbekcha 50,000+ articles Asturianu Azerbaycanca [JJJ[J] Bosanski s> ,sS Frysk Gaeilge Galeg;
Hrvatski Jo®mgmo Kurdi Latviesu Lietuviu 000000 Makemoucku (000000000 Norsk nynorsk 000000 Shaip Slovenscina 000 000000 s>, Retrieved from " 2 Calendar year Years Millennium 2nd millennium Centuries 12th century 13th century 14th century Decades 1240s 1250s 1260s 1270s 1280s Years 1258 1259 1260 1261 1262 1263 1264 vte 1261 by
topic Leaders Political entities State leaders Religious leaders Birth and death categories Births - Deaths Establishments and disestablishments categories Establishments - Disestablishments Art and literature 1261 in poetry vte 1261 in various calendarsGregorian calendar1261MCCLXIAb urbe condita2014Armenian calendar710(3J Q2dAssyrian
calendar6011Balinese saka calendarl182-1183Bengali calendar667-668Berber calendar2211English Regnal year45 Hen. 3 - 46 Hen. 3Buddhist calendar1805Burmese calendar623Byzantine calendar6769-6770Chinese calendarfEFE& (Metal Monkey)3958 or 3751 — to —¥ B (Metal Rooster)3959 or 3752Coptic calendar977-978Discordian
calendar2427Ethiopian calendar1253-1254Hebrew calendar5021-5022Hindu calendars - Vikram Samvat1317-1318 - Shaka Samvat1182-1183 - Kali Yuga4361-4362Holocene calendar11261Igbo calendar261-262Iranian calendar639-640Islamic calendar659-660Japanese calendarBun'oc 2 / Kocho 1(5ARItE)Javanese calendar1170-1171]Julian
calendar1261MCCLXIKorean calendar3594Minguo calendar651 before ROCR#i16515F Nanakshahi calendar—207Thai solar calendar1803-1804Tibetan calendarJJ00000000000000(male Iron-Monkey)1387 or 1006 or 234 — to —[J000000000000(female Iron-Bird)1388 or 1007 or 235 Michael VIII Palaiologos (1223-1282) Year 1261 (MCCLXI) was a
common year starting on Saturday of the Julian calendar. March 13 - Treaty of Nymphaeum: Emperor Michael VIII Palaiologos signs a trade and defense agreement with the Republic of Genoa, to counterweight the Venetian presence in the region. Genoa agrees to ally with the Empire of Nicaea, by providing a fleet of up to 50 galleys during the
projected Nicaean siege of Constantinople, while 16 galleys are to be immediately sent against the Latin Empire.[1] July - Michael sends his general Alexios Strategopoulos with a small advance force of 800 soldiers, most of them Cumans, to keep watch on the Bulgarians and scout the defending positions of the Latin forces in the surroundings of
Constantinople. When they reach the village of Selymbria, Strategopoulos is informed by local farmers that the entire Latin garrison and the Venetian fleet, are absent conducting a raid against the Nicaean island of Daphnousia. He decides not to lose such a golden opportunity and makes plans (without the consent of Michael) to retake the capital.[2]
July 25 - Reconquest of Constantinople: Alexios Strategopoulos and his men hide at a monastery near the city gates, before entering through a secret passage. After a short struggle, the guards who are completely taken by surprise are killed and the Venetian quarter is set ablaze. Panic spreads through the capital and Emperor Baldwin II rushes out to
save his life, evacuating along with many other Latins with the help of the Venetian fleet. Baldwin manages to escape to the still Latin-held parts of Greece, but Constantinople is lost for good.[3] August 15 - Michael enters Constantinople in triumph and is crowned as emperor of the Byzantine Empire at the Hagia Sophia. To solidify his claim, the
legitimate ruler, John IV Laskaris, is blinded on Michael's orders on December 25, his 11th birthday. Michael banishes him to a monastery and marries his two sisters to lesser Latin and Bulgarian nobles in an attempt to wipe out the Laskarid dynasty.[4] Kublai Khan releases 75 Chinese merchants who were captured along the border of the Mongol
Empire. By doing this, Kublai hopes to bolster his popularity and depend on the cooperation of his Chinese subjects to ensure that his army receives more resources.[5] June 13 - Al-Mustansir II becomes the first Abbasid ruler in Cairo (after his escape during the Siege of Baghdad). He is sent with an army by Sultan Baibars to recover Baghdad, but is
killed in a Mongol ambush near Anbar (modern Iraq), on November 28. The Abbasid caliphs continue as religious figureheads for the Mamluks in Egypt until the 16th century.[6] June 12 - King Henry III of England obtains a papal bull to absolve himself from his oath to maintain the Provisions of Oxford. He hires an army of 300 French knights as a
bodyguard and takes up position in the Tower of London. He dismisses the baronial officials (led by Simon de Montfort) who wish the royal power to be modified by the principle of representation. This sets the stage for the Second Barons' War.[7] August - Battle of Callann in Ireland: Norman forces under John FitzThomas are defeated by a Gaelic army
led by King Finghin Mac Carthaigh. John FitzGerald is killed during the fighting.[8] February - The Japanese Bun'0 era ends and the Kocho era begins during the reign of the 11-year-old Emperor Kameyama (until 1264). Early - Following disputes, northern academics from the University of Cambridge in England set up a University of Northampton by
royal charter but it is suppressed by the Crown in 1265.[9] The earliest extant Chinese illustration of "Pascal's Triangle" is from Yang Hui's (or Qianguang's) book Xiangjie Jiuzhang Suanfa, published this year. May 25 - Pope Alexander IV dies after a pontificate of 6-years at Viterbo. He is succeeded by Urban IV as the 182nd pope of the Catholic Church.
August 29 - Urban IV offers the crown of Sicily to Charles of Anjou, youngest son of King Louis VIII of France, hoping to strengthen his position. Wurmsbach Abbey (located in Bollingen) is established by Count Rudolf V of Rapperswil in Switzerland. February 1 - Walter de Stapledon, English bishop of Exeter (d. 1326) February 11 - Otto III, Duke of
Bavaria, king of Hungary and Croatia (d. 1312) February 28 - Margaret of Scotland, queen consort of Norway (d. 1283) March 1 - Hugh Despenser the Elder, English chief adviser (d. 1326) July 25 - Arthur II, Breton nobleman (House of Dreux) (d. 1312) October 9 - Denis I ("the Poet King"), king of Portugal (d. 1325) Abu Abdallah ibn al-Hakim,
Andalusian vizier and poet (d. 1309) November - 'Ala' al-Dawla Simnani, Persian Sufi mystic and writer (d. 1336) Albertino Mussato, Paduan statesman, poet and chronicler (d. 1329) Constantine Palaiologos, Byzantine prince and general, son of Michael VIII (d. 1306) Daniel of Moscow (Aleksandrovich), Russian prince (d. 1303) Zangpo Pal, Tibetan
religious leader (d. 1323) Elizabeth of Sicily, queen consort of Hungary (House of Anjou) (d. 1303) Konoe Iemoto, Japanese nobleman (kugyo) and regent (d. 1296) Pier Saccone Tarlati di Pietramala, Italian nobleman and condottiero (d. 1356) Wtadystaw I Lokietek ("Elbow-High"), king of Poland (d. 1333) February 28 - Henry III ("the Good"), duke of
Brabant (b. 1230) April 1 - Ahi Evran, Bektashi Sufi preacher and poet (b. 1169) May 25 - Alexander IV, pope of the Catholic Church (b. 1199) July 8 - Adolf IV of Holstein, German nobleman (House of Schaumburg) July 25 - Nicephorus II of Constantinople, Byzantine patriarch August - John FitzThomas, 1st Baron Desmond, Norman Irish nobleman,
killed in battle August 24 - Ela of Salisbury, English noblewoman (b. 1187) September 18 - Konrad von Hochstaden, German archbishop September 22/27 - Plaisance of Antioch, queen consort of Cyprus (b. 1235) October 27 - Sancho of Castile, Spanish archbishop (b. 1233) November 2 - Bettisia Gozzadini, Bolognese noblewoman and academic lawyer
(b. 1209) November 9 - Sanchia of Provence, Queen of the Romans, German queen consort (b. 1225) November 26 - Hojo Shigetoki, Japanese samurai (b. 1198) November 27 - Athanasius III of Alexandria, Egyptian pope November 28 - Al-Mustansir II, Abbasid ruler (caliph) of Cairo, killed Abu Bakr Ibn Sayyid al-Nas, Andalusian theologian (b. 1200) An-
Nasir Dawud, Kurdish ruler, Ayyubid ruler (emir) of Damascus (b. 1206) Benedict II of Esztergom, Hungarian chancellor, governor and archbishop Conrad I, Burgrave of Nuremberg ("the Pious"), German nobleman and knight (b. 1186) Qin Jiushao, Chinese mathematician and writer (b. 1202) Sayf al-Din Bakharzi, Persian poet and sheikh (b. 1190)
Stephen of Bourbon, French Dominican preacher (b. 1180) ©~ Steven Runciman (1952). A History of The Crusades. Vol III: The Kingdom of Acre, p. 240. ISBN 978-0-241-29877-0. ™ Bartusis, Mark C. (1997). The Late Byzantine Army: Arms and Society, 1204-1453, pp. 40-41. University of Pennsylvania Press. ISBN 0-8122-1620-2. ™ Nicol, Donald M.
(1993). The Last Centuries of Byzantium, 1261-1453, p. 35 (Second ed.). Cambridge: Cambridge University Press. ISBN 978-0-521-43991-6. ~ Hackel, Sergei (2001). The Byzantine Saint, p. 71 (2001 ed.). St. Vladimir's Seminary Press. ISBN 0-88141-202-3. ~ Rossabi, Morris (1988). Khubilai Khan: His Life and Times, p. 51. Los Angeles: University of
California Press. ISBN 978-0-520-06740-0. ©~ Lock, Peter (2013). The Routledge Companion to the Crusades. Routledge. p. 112. ISBN 9781135131371. ~ Williams, Hywel (2005). Cassell's Chronology of World History. London: Weidenfeld & Nicolson. pp. 144-146. ISBN 0-304-35730-8. ~ BBC History, July 2011, p. 12. ~ Lawrence, C. H. (1984). "The
University in State and Church". In Aston, T. H.; Catto, J. I. (eds.). The History of the University of Oxford. Vol. 1. Oxford University Press. Retrieved from " 30ne hundred years, from 1101 to 1200 See also: Renaissance of the 12th century Millennia 2nd millennium Centuries 11th century 12th century 13th century Timelines 11th century 12th century
13th century State leaders 11th century 12th century 13th century Decades 1100s 1110s 1120s 1130s 1140s 1150s 1160s 1170s 1180s 1190s Categories: Births - Deaths Establishments - Disestablishments vte Eastern Hemisphere at the beginning of the 12th century The 12th century is the period from 1101 to 1200 in accordance with the Julian
calendar. In the history of European culture, this period is considered part of the High Middle Ages and overlaps with what is often called the "'Golden Age' of the Cistercians". The Golden Age of Islam experienced significant development, particularly in Islamic Spain. In Song dynasty China, an invasion by Jurchens caused a political schism of north and
south. The Khmer Empire of Cambodia flourished during this century, while the Fatimids of Egypt were overtaken by the Ayyubid dynasty. Following the expansions of the Ghaznavids and Ghurid Empire, the Muslim conquests in the Indian subcontinent took place at the end of the century. Main article: 1100s The Ghurid Empire converted to Islam from
Buddhism. 1101: In July, the Treaty of Alton is signed between Henry I of England and his older brother Robert, Duke of Normandy in which Robert agrees to recognize Henry as king of England in exchange for a yearly stipend and other concessions. The agreement temporarily ends a crisis in the succession of the Anglo-Norman kings. 1101-1103:
David the Builder takes over Kakheti and Hereti (now parts of Georgia). 1102: King Coloman unites Hungary and Croatia under the Hungarian Crown. 1102: Muslims conquer Sefiorio de Valencia. 1103-1104: A church council is convened by King David the Builder in Urbnisi to reorganize the Georgian Orthodox Church. 1104: In the Battle of Ertsukhi,
King David the Builder defeats an army of Seljuks. 1104: King Jayawarsa of Kadiri (on Java) ascends to the throne.[citation needed] 1106: Battle of Tinchebray. 1107-1111: Sigurd I of Norway becomes the first Norwegian king to embark on a crusade to the Holy Land. He fights in Lisbon and on various Mediterranean isles and helps the King of
Jerusalem to take Sidon from the Muslims. 1108: By the Treaty of Devol, signed in September, Bohemond I of Antioch has to submit to the Byzantine Empire, becoming the vassal of Alexius I. 1109: On June 10, Bertrand of Toulouse captures the County of Tripoli (northern Lebanon/western Syria). 1109: In the Battle of Naklo, Boleslaus III Wrymouth
defeats the Pomeranians and re-establishes Polish access to the sea. 1109: On August 24, in the Battle of Hundsfeld, Boleslaus III Wrymouth defeats Emperor Henry V of Germany and stops German expansion eastward. Main article: 1110s 1111: On April 14, during Henry V's first expedition to Rome, he is crowned Holy Roman Emperor. 1113:
Paramavishnulok is crowned as King Suryavarman II in Cambodia. He expands the Khmer Empire and builds Angkor Wat during the first half of the century. He establishes diplomatic relations with China. 1115: The Georgian army occupies Rustavi in the war with the Muslims. 1115: In Java, King Kamesvara of Kadiri ascends to the throne. Janggala
ceases to exist and comes under Kadiri domination, highly possible under royal marriage. During his reign, Mpu Dharmaja writes Kakawin Smaradahana, a eulogy for the king which become the inspiration for the Panji cycle tales, which spread across Southeast Asia.[1] 1116: The Byzantine army defeats the Turks at Philomelion. 1116: Death of dofa
Jimena Diaz, governor of Valencia from 1099 to 1102. c. 1119: The Knights Templar are founded to protect Christian pilgrims in Jerusalem. Main article: 1120s A Black and White Photo of the 12th century Cuenca Cathedral (built from 1182 to 1270) in Cuenca, Spain 1120: On January 16, the Council of Nablus, a council of ecclesiastic and secular lords
in the crusader Kingdom of Jerusalem, establishes the first written laws for the kingdom. 1120: On November 25, William Adelin, the only legitimate son of King Henry I of England, drowns in the White Ship Disaster, leading to a succession crisis which will bring down the Norman monarchy of England. 1121: On August 12, in the Battle of Didgori, the
greatest military victory in Georgian history, King David the Builder with 45,000 Georgians, 15,000 Kipchak auxiliaries, 500 Alan mercenaries and 100 French Crusaders defeats a much larger Seljuk-led Muslim coalition army. 1121: On December 25, St. Norbert and 29 companions make their solemn vows in Premontre, France, establishing the
Premonstratensian Order. 1122: The Battle of Beroia (Modern-day Stara Zagora, Bulgaria) results in the disappearance of the Pechenegs Turkish tribe as an independent force. 1122: On September 23, the Concordat of Worms (Pactum Calixtinum) is drawn up between Emperor Henry V and Pope Calixtus II bringing an end to the first phase of the power
struggle between the papacy and the Holy Roman Empire. 1122: King David the Builder captures Tbilisi and declares it the capital city of Georgia, ending 400 years of Arab rule. 1123: The Jurchen dynasty of China forces Koryo (now Korea) to recognize their suzerainty. 1124: In April or May, David I is crowned King of the Scots. 1125: On June 11, in the
Battle of Azaz, the Crusader states, led by King Baldwin II of Jerusalem, defeat the Seljuk Turks. 1125: In November, the Jurchens of the Jin dynasty declare war on the Song dynasty, beginning the Jin-Song wars. 1125: Lothair of Supplinburg, duke of Saxony, is elected Holy Roman Emperor instead of the nearest heir, Frederick of Swabia, beginning the
great struggle between Guelphs and Ghibellines. 1127: The Northern Song dynasty loses power over northern China to the Jin dynasty. 1128: On June 24, the Kingdom of Portugal gains independence from the Kingdom of Ledn at the Battle of Sdo Mamede; (recognised by Ledn in 1143). Main article: 1130s The temple complex of Angkor Wat, built
during the reign of Suryavarman II in Cambodia of the Khmer Era. 1130-1180: 50-year drought in what is now the American Southwest. 1130-1138: Papal schism, Pope Innocent II vs. Antipope Anacletus II. 1130: On March 26, Sigurd I of Norway dies. A golden era of 95 years comes to an end for Norway as civil wars between the members of Harald
Fairhair's family line rage for the remainder of the century. 1130: On Christmas Day, Roger II is crowned King of Sicily, the royal title being bestowed on him by Antipope Anacletus II. 1132: The Southern Song dynasty establishes China's first permanent standing navy, although China had a long naval history prior. The main admiral's office is at the port
of Dinghai. 1132-1183: the Chinese navy increases from a mere 3,000 to 52,000 marine soldiers stationed in 20 different squadrons. During this time, hundreds of treadmill-operated paddle wheel craft are assembled for the navy to fight the Jin dynasty in the north. 1135: King Jayabaya of Kadiri ascends to the throne.[2] 1135-1154: The Anarchy takes
place, during a period of civil war in England. 1136: Suger begins rebuilding the abbey church at St Denis north of Paris, which is regarded as the first major Gothic building. 1137: On July 22, the future King Louis VII of France marries Eleanor, the Duchess of Aquitaine. 1138: On October 11, the 1138 Aleppo earthquake devastates much of northern
Syria. 1139: in April, the Second Lateran Council ends the papal schism. 1139: On July 5, in the Treaty of Mignano, Pope Innocent II confirms Roger II as King of Sicily, Duke of Apulia, and Prince of Capua and invests him with his titles. 1139: On July 25, the Portuguese defeat the Almoravids led by Ali ibn Yusuf in the Battle of Ourique; Prince Afonso
Henriques is acclaimed King of Portugal by his soldiers. Main article: 1140s Averroes in a 14th-century painting by Andrea di Bonaiuto 1140-1150: Collapse of the Ancestral Puebloan culture at Chaco Canyon (modern-day New Mexico). 1141: The Treaty of Shaoxing ends the conflict between the Jin dynasty and Southern Song dynasty, legally
establishing the boundaries of the two countries and forcing the Song dynasty to renounce all claims to its former territories north of the Huai River. The treaty reduces the Southern Song into a quasi-tributary state of the Jurchen Jin dynasty. 1143: Manuel I Komnenos is crowned as Byzantine emperor after the death of John II Komnenos. 1143: Afonso
Henriques is proclaimed King of Portugal by the cortes. 1143: The Treaty of Zamora recognizes Portuguese independence from the Kingdom of Ledén. Portugal also recognizes the suzerainty of the pope. 1144: On December 24, Edessa falls to the Atabeg Zengi. 1145-1148: The Second Crusade is launched in response to the fall of the County of Edessa.
1147: On October 25, the four-month-long Siege of Lisbon successfully brings the city under definitive Portuguese control, expelling the Moorish overlords. 1147: A new Berber dynasty, the Almohads, led by Emir Abd al-Mu'min, takes North Africa from the Almoravides and soon invades the Iberian Peninsula. The Almohads began as a religious
movement to rid Islam of impurities. 1147: The Wendish Crusade against the Polabian Slavs (or "Wends") in what is now northern and eastern Germany. Main article: 1150s 1150: Ramon Berenguer IV, Count of Barcelona marries Petronilla, the Queen of Aragon. 1151: The Treaty of Tudilén is signed by Alfonso VII of Leén and Raymond Berengar IV,
Count of Barcelona, recognizing the Aragonese conquests south of the Jucar and the right to expand in and annex the Kingdom of Murcia. 1153: The Treaty of Wallingford, ends the civil war between Empress Matilda and her cousin King Stephen of England fought over the English crown. Stephen acknowledges Matilda's son Henry of Anjou as heir.
1153: The First Treaty of Constance is signed between Emperor Frederick I and Pope Eugene III, by the terms of which, the emperor is to prevent any action by Manuel I Comnenus to reestablish the Byzantine Empire on Italian soil and to assist the pope against his enemies in revolt in Rome. 1154: the Moroccan-born Muslim geographer Muhammad al-
Idrisi publishes his Geography. 1154: On December 27, Henry II is crowned King of England at Westminster Abbey. 1155: Pope Adrian IV grants overlordship of Ireland to Henry II of England in the bull Laudabiliter. 1156: On June 18, the Treaty of Benevento is entered into by Pope Adrian IV and the Norman Kingdom of Sicily. After years of turbulent
relations, the popes finally settles down to peace with the Hauteville kings. The kingship of William I is recognized over all Sicily, Apulia, Calabria, Campania, and Capua. The tribute to the pope of 600 schifati agreed upon by Roger II in 1139 at Mignano is affirmed and another 400 shift is added for the new lands. 1158: The Treaty of Sahagin ends the
war between Castile and Le6n. Main article: 1160s The Liuhe Pagoda of Hangzhou, China, 1165 1161: the Song dynasty Chinese navy, employing gunpowder bombs launched from trebuchets, defeats the enormous Jin dynasty navy in the East China Sea in the Battle of Tangdao and on the Yangtze River in the Battle of Caishi. 1161: Kilij Arslan II, Sultan
of Rum, makes peace with the Byzantine Empire, recognizing the emperor's primacy. 1161: In the siege of Ani, troops from the Kingdom of Georgia take control over the city, only to have it sold for the second time to the Shaddadids, a Kurdish dynasty. 1162: Genghis Khan, the founder of the Mongol Empire, is born as Temiijin in present-day Mongolia.
1163: The Norwegian Law of Succession takes effect. 1165-1182: Tensions and disputes between the Pagan Empire and the Kingdom of Polonnaruwa causes the Sinhalese under Parakramabahu the Great to raid Burma. 1168: King Valdemar I of Denmark conquers Arkona on the Island of Rigen, the strongest pagan fortress and temple in northern
Europe. 1169: Political disputes within the Pandya Empire sparks the decade-long Pandyan Civil War. 1169: On May 1, the Norman invasion of Ireland begins. Richard fitzGilbert de Clare ('‘Strongbow') allies with the exiled Irish chief, Dermot MacMurrough, to help him recover his kingdom of Leinster. Main article: 1170s The defense of the Carroccio
during the battle of Legnano (1176) by Amos Cassioli (1832-1891) 1170: The Treaty of Sahagun is signed by Alfonso VIII of Castile and Alfonso II of Aragon. Based on the terms of the accord, Alfonso VIII agrees to provide Alfonso II with three hostages, to be used as tribute payments owed by Ibn Mardani$ of Valencia and Murcia. 1170: On December
29, Thomas Becket is murdered in Canterbury Cathedral. 1171: Saladin deposes the last Fatimid Caliph Al-'Adid and establishes the Ayyubid dynasty. 1171: On November 11, Henry II of England lands in Ireland to assert his claim as Lord of Ireland. 1172: The Pandyan city of Madurai is sacked by the Sinhalese army due to an attempt to drive off the
rival throne claimant, Kulasekara Pandyan. 1173: Sinhalese king Parakramabahu the Great gains a decisive victory by invading the Chola Empire as an ally of the Pandyas in the Pandyan Civil War. 1174: On July 12, William I of Scotland is captured by the English in the Battle of Alnwick. He accepts the feudal overlordship of the English crown and pays
ceremonial allegiance at York. 1175: Honen Shonin (Genki) founds the Jodo shi (Pure Land) sect of Buddhism. 1175: The Treaty of Windsor is signed by King Henry II of England and the High King of Ireland, Ruaidri Ua Conchobair. 1176: On May 29, Frederick Barbarossa's forces are defeated in the Battle of Legnano by the Lombard League which
results in the emperor's acknowledgment of the pope's sovereignty over the Papal States and Alexander acknowledging the emperor's overlordship of the imperial Church. 1176: On September 17, The Battle of Myriokephalon (Myriocephalum; Turkish: Miryakefalon Savasi) is fought between the Byzantine Empire and the Seljuk Turks in Phrygia. It is a
serious reversal for the Byzantine forces and will be the final, unsuccessful, effort by the Byzantines to recover the interior of Anatolia from the Seljuk Turks. 1177: The Treaty or Peace of Venice is signed by the papacy and its allies, and Frederick I, Holy Roman Emperor. The Norman Kingdom of Sicily also participates in negotiations and the treaty
thereby determines the political course of all of Italy for the next several years. 1178: Chinese writer Zhou Qufei, a Guangzhou customs officer, writes of an island far west in the Indian Ocean (possibly Madagascar), from where people with skin "as black as lacquer" and with frizzy hair were captured and purchased as slaves by Arab merchants. 1179:
The Treaty of Cazola (Cazorla) is signed by Alfonso IT of Aragon and Alfonso VIII of Castile, dividing Andalusia into separate zones of conquest for the two kingdoms, so that the work of the Reconquista would not be stymied by internecine feuding. Main article: 1180s 1180: The Portuguese Navy defeats a Muslim fleet off the coast of Cape Espichel. 1180-
1185: the Genpei War in Japan. 1181: Parakramabahu the Great conducts a large-scale raid on Burma, after a ship transporting a Sinhalese princess to the Khmer Empire is attacked by Burmese naval fleets. 1182: Religious reformations of Theravada Buddhism in Pagan Burma under the patronage of Narapatisithu are continued with the end of the
Polonnaruwa-Pagan War. 1182: Revolt of the people of Constantinople against the Latins, whom they massacre, proclaiming Andronicus I Comnenus as co-emperor. 1183: On January 25, the final Peace of Constance between Frederick Barbarossa, the pope and the Lombard towns is signed, confirming the Peace of Venice of 1177. 1183: On September
24, Andronicus I Comnenus has his nephew Alexius II Comnenus strangled. 1184: On March 24, Queen Tamar, King of Georgia, accedes to the throne as sole ruler after reigning with her father, George III, for six years. 1184: Diet of Pentecost organised by Emperor Frederick I in Mainz. 1185: The Uprising of Asen and Peter against the Byzantine
Empire leads to the restoration of the Bulgarian Empire. 1185: Andronicus I Comnenus is deposed and, on September 12, executed as a result of the Norman massacre of the Greeks of Thessalonika. 1185: The cathedral school (Katedralskolan) in Lund, Sweden, is founded. The school is the oldest in northern Europe and one of the oldest in all of Europe.
1185: Beginning in this year the Kamakura shogunate deprives the emperor of Japan of political power. 1186: On January 27, the future Holy Roman Emperor Henry VI marries Constance of Sicily, the heiress to the Sicilian throne. 1187: On July 4, in the Battle of Hattin, Saladin defeats the king of Jerusalem. 1187: In August, the Swedish royal and
commercial center Sigtuna is attacked by raiders from Karelia, Couronia, and/or Estonia.[3] 1188: The Riah were introduced into the Habt and south of Tetouan by the Almohad caliph, Abu Yusuf Yaqub al-Mansur, and Jochem and Acem were introduced in Tamesna.[4] 1189: On September 3, Richard I is crowned King of England at Westminster. 1189:
On November 11, William II of Sicily dies and is succeeded by his illegitimate cousin Tancred, Count of Lecce instead of Constance. 1189-1192: The Third Crusade is an attempt by European leaders to wrest the Holy Land from Saladin. Main articles: 1190s and 1200s Richard I of England, or Richard the Lionheart. 1190: On June 10, Emperor Frederick
Barbarossa drowns in the River Salef, leaving the Crusader army under the command of the rivals Philip II of France and Richard I of England, which ultimately leads to the dissolution of the army. 1191: Holy Roman Emperor Henry VI attacked the Kingdom of Sicily from May to August but fails and withdrawn, with Empress Constance captured
(released 1192). 1191: On September 7, Saladin is defeated by Richard I of England at the Battle of Arsuf. 1192: In April, Isabella I begins her reign as Christian Queen of the Kingdom of Jerusalem 1192: In the Battle of Jaffa, King Richard the Lionheart defeats Saladin. 1192: In June, the Treaty of Ramla is signed by Saladin and Richard Lionheart. Under
the terms of the agreement, Jerusalem will remain under Muslim control. However, the city will be open to Christian pilgrims. The Latin Kingdom is reduced to a coastal strip that extends from Tyre to Jaffa. 1192: Minamoto no Yoritomo is appointed Sei-i Taishogun, "barbarian-subduing great general”, shogun for short, the first military dictator to bear
this title. 1192: Sultan Shahabuddin Muhammad Ghori establishes the first Muslim empire in India for 14 years (1192-1206) by defeating Prithviraj Chauhan. 1193: Nalanda, the great Indian Buddhist educational centre, is destroyed. 1194: Emperor Henry VI conquers the Kingdom of Sicily. 1195: On June 16, the struggle of Shamqori. Georgian forces
annihilate the army of Abu Baqgar. 1198: The brethren of the Crusader hospital in Acre are raised to a military order of knights, the Teutonic Knights, formally known as the Order of the Knights of the Hospital of St. Mary of the Teutons in Jerusalem. 1199: Pope Innocent III writes to Kaloyan, inviting him to unite the Bulgarian Church with the Roman
Catholic Church. 1200: Construction begins on the Grand Village of the Natchez near Natchez, Mississippi. This ceremonial center for the Natchez people is occupied and built until the early 17th century.[5] Eastern Hemisphere at the end of the 12th century China is under the Northern Song dynasty. Early in the century, Zhang Zeduan paints Along
the River During the Qingming Festival. It will later end up in the Palace Museum, Beijing. In southeast Asia, there is conflict between the Khmer Empire and the Champa. Angkor Wat is built under the Hindu king Suryavarman II. By the end of the century, the Buddhist Jayavarman VII becomes the ruler. Japan is in its Heian period. The Chagju-jinbutsu-
giga is made and attributed to Toba So6jo. It ends up at the Kozan-ji, Kyoto. In Oceania, the Tu‘i Tonga Empire expands to a much greater area. Europe undergoes the Renaissance of the 12th century. The blast furnace for the smelting of cast iron is imported from China, appearing around Lapphyttan, Sweden, as early as 1150. Alexander Neckam is the
first European to document the mariner's compass, first documented by Shen Kuo during the previous century. Christian humanism becomes a self-conscious philosophical tendency in Europe. Christianity is also introduced to Estonia, Finland, and Karelia. The first medieval universities are founded. Pierre Abelard teaches. Middle English begins to
develop, and literacy begins to spread outside the Church throughout Europe.[6] In addition, churchmen are increasingly willing to take on secular roles. By the end of the century, at least a third of England's bishops also act as royal judges in secular matters.[7] The Ars antiqua period in the history of the medieval music of Western Europe begins. The
earliest recorded miracle play is performed in Dunstable, England. Gothic architecture and trouvére music begin in France. During the middle of the century, the Cappella Palatina is built in Palermo, Sicily, and the Madrid Skylitzes manuscript illustrates the Synopsis of Histories by John Skylitzes. Fire and plague insurance first become available in
Iceland, and the first documented outbreaks of influenza there happens. The medieval state of Serbia is formed by Stefan Nemanja and then continued by the Nemanji¢ dynasty. By the end of the century, both the Capetian dynasty and the House of Anjou are relying primarily on mercenaries in their militaries. Paid soldiers are available year-round,
unlike knights who expected certain periods off to maintain their manor lifestyles.[8] In India, Hoysala architecture reaches its peak. In the Middle East, the icon of Theotokos of Vladimir is painted probably in Constantinople. Everything but the faces will later be retouched, and the icon will go to the Tretyakov Gallery of Moscow. The Georgian poet
Shota Rustaveli composes his epic poem The Knight in the Panther's Skin. Shahab al-Din Suhrawardi founds his "school of illumination". In North Africa, the kasbah of Marrakesh is built, including the city gate Bab Agnaou and the Koutoubia mosque. In sub-Saharan Africa, Kente cloth is first woven. In France, the first piedfort coins were minted. The
city of Tula burns down, marking the end of the Toltec Empire In West Africa the Ife Empire is established. See also: Timeline of historic inventions § 12th century 1104: The Venice Arsenal of Venice, Italy, is founded. It employed some 16,000 people for the mass production of sailing ships in large assembly lines, hundreds of years before the Industrial
Revolution. 1106: Finished building of Gelati. 1107: The Chinese engineer Wu Deren combines the mechanical compass vehicle of the south-pointing chariot with the distance-measuring odometer device. 1111: The Chinese Donglin Academy is founded. 1165: The Liuhe Pagoda of Hangzhou, China, is built. 1170: The Roman Catholic notion of Purgatory
is defined.[9] 1185: First record of windmills. Wikimedia Commons has media related to 12th century. ©~ Soekmono, R, Drs., Pengantar Sejarah Kebudayaan Indonesia 2, 2nd ed. Penerbit Kanisius, Yogyakarta, 1973, 5th reprint edition in 1988 p.57 ~ Britannica, T. Editors of Encyclopaedia (1998, July 20). Kadiri. Encyclopedia Britannica. ~ Enn Tarvel
(2007). Sigtuna hukkumine. Archived 2017-10-11 at the Wayback Machine Haridus, 2007 (7-8), p 38-41 ™ Notice sur les Arabes hilaliens. Ismaél Hamet. p. 248. ©~ Francine Weiss and Mark R. Barnes (May 3, 1989). "National Register of Historic Places Registration: Grand Village of the Natchez Site / Fatherland Plantation Site (22-Ad-501)" (pdf).
National Park Service. and Accompanying 3 photos, from 1989. (680 KB) ©~ Warren 1961, p. 129. ™ Warren 1961, p. 159. ™~ Warren 1961, p. 60-61. ™ Le Goff, Jacques (1986). The Birth of Purgatory. Chicago: University of Chicago Press. ISBN 0226470822. Warren, Wilfred Lewis (1961). King John. University of California Press. p. 362.
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using Acrobat Pro. Foxit PDF Reader is a lightweight yet powerful alternative to Adobe Acrobat. If you're wondering how to remove highlight from Foxit PDF, the process is simple and ideal for users who want to clean up their documents without much effort. Foxit’s Comments panel allows you to remove all highlight annotations at once saving you from
deleting them one by one. Allows bulk deletion of all highlight comments Fast, responsive, and light on system resources Free version includes most essential editing features Multi-select option is only available on Windows desktop version No full support for bulk actions on Mac Slightly less intuitive interface for beginners How to Remove Highlight
from Foxit PDF Windows: Open the PDF file in Foxit PDF Editor or Foxit PDF Reader for Windows. Click the “Comments” panel on the left side of the screen. Sort the comments by type so you can view all highlights grouped together. Double-click the "Highlight" comment category to expand and list all highlighted items. Select the last comment, then
hold Shift and click the first one to select all highlight comments in one go. Right-click on the selected comments and choose “Delete” from the menu. All highlights will be removed instantly. PDF XChange Editor is a fast, lightweight, and feature-rich PDF tool used by many professionals. Whether you're editing, annotating, or viewing documents, it
offers impressive control and speed. If you're figuring out how to remove highlight from PDF XChange Editor, the process is quick either remove all highlights at once or just a few using smart tools built right in. Fast and efficient with a light system footprint Free version includes essential editing features Allows individual or bulk highlight removal
Offers precise annotation control Supports keyboard shortcuts for faster workflow Interface may feel cluttered for beginners Some features locked behind Pro version No built-in OCR in free version Not available on macOS Steps - How to Remove Highlight from PDF XChange Editor: Open your PDF in PDF XChange Editor. Press Ctrl+M or open the
Comments Pane from the left sidebar. Group comments by type to show all highlights together. Select the first and last highlight while holding Shift, or use Ctrl+A to select all. Press the Delete key on your keyboard to remove all highlights instantly. To Delete Individual Highlights: Activate the “Select Comments” tool from the toolbar/ribbon. Click on
the highlighted area you want to remove. Press the Delete key or right-click and choose “Delete” from the menu. Save your file to keep the changes. Microsoft Edge, the default browser on Windows, doubles as a basic PDF viewer and editor. It allows users to make simple edits like adding or removing highlights without installing any extra software. Pre-
installed on most Windows systems 100% free to use No need to download third-party tools Simple and clean interface Quick saving without watermark Only supports basic PDF editing Can’t remove multiple highlights at once No annotation history or preview Requires a stable internet connection for full performance Steps - How to Remove Highlight
from PDF Microsoft Edge: Right-click your PDF file and select “Open with > Microsoft Edge.” Locate the highlighted text in the document. Right-click on the highlighted section and select “Highlight” > “None.” The highlight will disappear immediately. Click the Save icon at the top to preserve the changes. Mac users don’t need third-party software to
handle simple PDF edits. The built-in Preview app offers a fast and free way to view, annotate, and remove highlights from PDFs. Whether you want to delete a single highlight or erase an entire page with annotations, here's how to remove highlight from PDF in Preview easily and effectively. Pre-installed on all Mac devices Free and easy to use Simple
interface, great for beginners Fast performance with no installation needed Can’t remove highlights individually only by page No batch deletion option for multiple highlights Basic editing features only Not suitable for large or complex PDF edits Steps - How to Remove Highlight from PDF in Preview (Mac): Locate your PDF file and open it with Preview.
Click on View > Thumbnails or View > Contact Sheet to see all pages. Select the page(s) that contain the highlights you want to remove. Press the Delete key on your keyboard or go to Edit > Delete. Note: This method deletes the entire page, including any annotations and highlights. If you only want to erase highlights, consider using a more advanced
Tenoshare PDNob PDF editor. To remove a yellow highlight, open your PDF in a supported editor and click on the highlighted text. You’ll see an option to delete or remove the highlight. Simply select it, and the highlight will be gone. 2. What should I do if I only have the highlighted PDF and not the original file You can still remove highlights without
needing the original version. The highlight is just an overlay and doesn't affect the actual text. Use a PDF editor that allows highlight removal, and your content will stay intact. 3. Why does the annotation stay after I delete the highlight Some PDF tools treat highlights and comments separately. Even if the highlight is removed, the note or comment
might remain. Check the comments panel and delete any extra annotations manually. 4. Is it safe to use online services to delete highlights from a PDF It’s generally safe to use trusted online tools for non-sensitive files. However, if your document contains private or important information, it's better to use desktop software to protect your data.
Understanding how to remove highlight from PDF can make your document editing experience much smoother. Whether you're tidying up study notes or preparing a clean professional file, the right tool makes all the difference. While there are many options available, Tenorshare PDNob offers a smart, reliable, and efficient solution. With its advanced
features and user-friendly design, it takes the stress out of PDF editing and helps you get the job done with ease and precision. The END I am PDNob. Swift editing, efficiency first. Make every second yours: Tackle any PDF task with ease. As Leonardo da Vinci said, "Simplicity is the ultimate sophistication." That's why we built PDNob. Registrer/ Login
then write your review Portable document format (or PDF) is a universal document format that allows creators of PDFs to add emphasis to certain sections of a document by highlighting the text in Adobe Acrobat. Readers of the documents can add and remove highlighted text from a document if the creator has enabled commenting in Adobe Reader.
Click "Start," "All Programs" and then "Adobe Acrobat/Reader." Click "File" and then "Open" from the top menu. Click the PDF document of choice and then click the "Open" button. Click and then drag the mouse cursor over the text you wish to remove the highlighting from. Click "Tools" from the top menu and then click the "Highlight Text" tool. The
highlight text tool looks like a "T" with a marker. The highlight is removed from the text. Repeat steps 3 and 4 to remove highlighting from additional text in the Adobe document.
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